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ACIS®

What is it, and why use it?

Where is Advantage in a 
Competitive World?

• People
• Technical
• Reputation
• Information
• Timing

Have you heard this?

• “You mean we’ve looked at that 
deal before?”

• “I could have told you that would 
never fly.”

• “How come we didn’t know 
about that?”
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Have you thought this?

• “How the hell did that happen?”
• “If only I knew that a few months 

ago….”
• “That might be useful to us, but 

who would I tell?”
• “Where IS IT!?”

The Current Information 
Challenges

• Too much stuff
• Too difficult to find what we need
• Lots of hype and unrealistic 

expectations about what 
technology can do

What do we need?

• Solid reference information on 
what we are involved in

• News on what we’re involved in
• A “corporate memory”
• Early warnings of opportunities 

and threats
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The Challenge to Finding It

What ACIS Does: I

• It provides the ability to share what we 
hear and think:
– Communicate something picked up in one 

location that is relevant to another
– Communicate things you know that others don’t 

about projects and initiatives underway
– Discover early warning signals of opportunities 

and threats
• It creates a corporate memory around 

projects, companies, and other areas of 
focus

What ACIS Does: II

• Weaves internal intelligence with news, 
technical and financial data, and 
documents 
– to make everything about a project accessible 

from one place

• Creates project workspaces
– enabling us to save time and effort, and move 

effectively from discovery to action
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How ACIS® Is Structured
Internal and External Databases

Primary Intelligence
From Newmont Staff Documents News feeds

ACISACIS®®

Intelligence on Targets Real-time AlertsReports

Discovery

Document Management Workplaces
Action Support

How ACIS® Works

Early Warning Signals

• A VP Explo is battling with the CEO
• A company is trying to push three 

large projects through feasibility 
simultaneously

• A project quietly increases the size of 
its pilot plant

• A few local consultants are suddenly 
unavailable
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Information is Everywhere
• We come across the same competitors around 

the world, and useful information about them or 
their projects might be heard anywhere

• Through our individual networks
• Through discussions with

– colleagues in the field
– contractors, 
– consultants, 
– bankers, 
– partners, 
– competitors, 
– analysts, or
– friends 

What is relevant?

• Intelligence which does or may 
indicate something Newmont 
should act on

• We have an initial set of criteria; 
this can be added to and modified
– The key is that its things we’re 

already hearing or thinking
– No need to analyze their meaning

The Power of Sharing: 
Finding the Elephant
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Mining
Information Gold

The result is much more 
gold at a much cheaper 
cost

ACIS® extracts the “gold”
of critical information from 
the high grade zone of real-
time human intelligence

Users filter what is 
potentially gold into the 
system…

…while the system filters 
further what is critical to each 
user

Early Warnings

Individual filters

ACIS®
Learning ACIS® Functionality

(Module II)
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Module II - Learning ACIS® Functionality 
 
Introduction 
 
This module is a demonstration and practice session.  The overall objective is to 
demonstrate and perform the major functions of ACIS®.  Your trainer will 
demonstrate the functions of ACIS® by taking you through specific examples of 
investigating an interesting initiative in a mining project. You will then be able to 
practice the functions yourself.   
 
Items where you interact with the system are signified by an ACTION box. 
i.e.: 
 
ACTION:  
  
 Login to the system using the username and password you have been 
 provided. 
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System overview 
 
Objectives: 
 

- To utilize the “Remember me?” feature. 
- To access the Intelligence Quick Add function. 
- To become familiar with the overall structure of the ACIS® user interface 

and its terminology. 
 

 

 
Figure 1 – ACIS® Login Screen 

 
The “Remember me?” checkbox on the login screen allows automatic login from 
your computer. By checking this box you will be required to enter your User 
name and Password once on each new computer you use to access ACIS. Once 
this box is checked the ACIS URL will immediately launch the homepage. 
 
There are two ways to login to the system.  
 

1. Main ACIS System  
2. Intelligence Quick Add 

 
Selecting “Main ACIS System” will launch the ACIS homepage. Intelligence 
Quick Add provides a streamlined means of adding intelligence. 
 
ACTION:  
 
           1. Login to the system using the user name and password you have been  
     provided. Click the Remember me? check box 
 

 2. Logout of the system by clicking  in the upper right hand corner of  
     the ACIS interface. Close the browser window and launch ACIS again. 
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Selecting “Intelligence Quick Add” will launch a simplified screen for adding flag-
intelligence to ACIS. “Intelligence Quick Add” is useful when using a slow or dial-
up connection as its graphics are streamlined for fast loading. This feature is also 
useful if you want to quickly add a piece of intelligence without going into the full 
system. 
 
ACTION:  
 
           1. Logout of the system again. 
 
 2. Select “Intelligence Quick Add” from the Enter drop-down box.  
     (Figure 2) 
 
 3. Note the difference in the interface. (Figure 3) (We will explore how to     
     add flags in a future section.) 
 
 4. Click on the Home button to launch the Main ACIS homepage.  
     (Figure 4) 
 
 5. Review the Homepage windows and tab pages. (Figure 5 – 11) 
   
 

 
Figure 2 – Selecting Intelligence Quick Add 

 

 
Figure 3 –Intelligence Quick Add Screen 
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ACIS View 
Your system has been set up with a number of categories. Each of the entries 
within a category, such as a specific project or company, is called an ACIS View, 
each composed of Profile, Flags, Documents and News pages. This information 
is woven together to produce a contextualized, robust view of your business 
environment. 
 

 
 
The ACIS View: 

• A Profile of the technical information 
• Flags for capturing the soft data 
• A page for Documents related specifically to that item  
• News which has been automatically or manually linked 

 

 
ACIS View Pages 

 
 
ACIS® Homepage   
The system opens up to a portal that tracks real-time internal and external 
intelligence, both as it comes in, and filtered according to each user’s specific 
interests. 
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Figure 4 – ACIS® Homepage 

 
Intelligence Window 
The Intelligence Window displays the latest internal human intelligence, 
provided by your colleagues.  Each user types in comments and the system 
assigns the other information. You can click on any user’s name and send an 
email to them. The paperclip icon indicates that there is a web site attachment 
with the comment. 
 
News Window 
Whatever news pipelines your company designates run through the News 
Window on the homepage—it can be one or several sources.  In this case, we 
are using Yahoo Mining sources. 
 
Alerts Window 
Alerts appear in the Alerts window on the ACIS® homepage, and on the Alerts 
page. On the Homepage, only high priority alerts are shown. Alerts include 
information on items that have changed in any Saved Searches, and any email-
based notifications from outside the ACIS® system that you choose to have sent 
to this window. (By default, alerts remain on the homepage for a period of six 
weeks.) 
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Tabs 
The tab header navigation has links to Alerts, Intelligence, News, Documents, 
Search, and Workspaces. 
 

 
Figure 5 – ACIS® Tab Header 

 
Alerts tab 
Alerts include information on items that have changed in any Saved Searches 
(Done from either the News or ACIS View Searches) or any new Notifications. 
The columns can be individually sorted in chronological or alphabetical order 
(forward or reverse). All levels of alerts (H, M, L) appear on this page. 
 

 
Figure 6 – ACIS® Alerts Page 

 
Intelligence tab 
The Intelligence page captures all of the internal intelligence entered into the 
system in chronological order.  
 
You can search intelligence by key word(s), submitter and/or a date range.  
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Intelligence can be filtered by ACIS View category (Projects, Companies, People, 
Countries) using the “Show Intelligence for” drop-down box. 
 
By default only the first 200 characters of an Intelligence comment appears. 
Checking the “Show full comments?” box will reveal all text included in each 
entry. Alternately you can click on “[ more ]” following a truncated comment. This 
will take you to the Flags page to view the entire comment plus others related to 
the flag topic. 
 
The homepage window shows the latest entries in the Intelligence window. 
 

 
Figure 7 – ACIS® Intelligence Page 

 
News tab 
All the news is archived in the news section, with the ability to search it, access 
the full text, and then link it to relevant ACIS Views.  
 

 
Figure 8 – ACIS® News Page 
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Documents tab 
The contents of the Documents tab allows you to filter and search all documents 
contained within the ACIS system. That includes documents in ACIS Views and 
any workspaces of which you are a member. 
 

 
Figure 9 – ACIS® Documents Search Page 

 
Search tab 
The Search section in ACIS® allows you to filter and set alerts based on multiple 
criteria in the system. From this section you can search for any        ACIS View 
within a category, adding criteria from profile and intelligence flag data to narrow 
your search. Your results will allow you to access detailed information from 
sections of any ACIS View in the system. 
 

 
Figure 10 – ACIS® Search Page 
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Workspaces tab  
ACIS® Workspaces are private, secure areas designed to provide a user or a 
group of users with a space for documentation and resource collection, project 
task management and archiving of email-based discussions. Workspaces can 
also be linked to the rest of the system and receive alerts on new developments 
of interest to the particular focus of the workspace.  
 
Workspaces can be used as areas to collect and manage project-related 
information, conduct strategy reviews, pursue watching briefs, or investigate key 
questions. 
 
Workspaces can also be used to track information on groups of ACIS Views 
and/or a combination of saved search results. 
 
A Workspace owner can create flags for other members of the Workspace to 
use. This can be useful for tracking specific questions or developments 
pertaining to the subject of that Workspace. 
 
The My Workspaces page offers users a quick overview of new activities in the 
Workspaces area. New Documents, Alerts, Emails and Intelligence Flag 
Comments are indicated by numbers in the columns next to each Workspace 
name. 
 

 
Figure 11 – My Workspaces Page 
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NOTES: 
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Looking at system functionality in depth 
 
A. Flags 
 
Objectives: 
 

- To find and read information from the Intelligence window. 
- To find and read information on the Flags page. 

 
 
On the Homepage, in the Intelligence window, we notice some interesting 
information someone else has put into ACIS®. Let's look at the Flags page (i.e. 
Canariaco). 
 
ACTION:  
  
 1. If you have not done so, login to the system using the username and  
     password you have been provided. 
 
 2. In the Intelligence window click on the name of an ACIS View (i.e. 

    Canariaco). (Figure 1A). Note that the flag you selected from the  
    Homepage is open. 

 
 3. You are now at the Flags page. (Figure 2A). Read through the flags  
     categories and flags. 
 
 

 
Figure 1A –Intelligence on Homepage 
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Figure 2A – Flags Page 
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NOTES: 
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B. Profile 
 
Objectives: 
 

- To find and read information on the Profile page. 
 
 
We now want to look further at the information on this ACIS View. We’ll start by 
looking at the contents of the Profile. Information for Project profiles is uploaded 
on a monthly basis from MineSearch and represents a summary of key 
information in that database. 
 
ACTION:  
 
 1. On the Flags page click on the View menu. From the drop-down list 

    select Profile. (Figure 1B) 
 

2. Scan down through the list of profile inclusions. (Figure 2B)  
 
 
 

 
Figure 1B – Profile Menu Option 
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Figure 2B – Profile Page 



   

ACIS® Orientation and Training Guide  16 

NOTES: 
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C. Edit Profile and Viewing History 
 
Objectives: 
 

- To edit fields on the Profile page.  
- To view History for items changed on the Profile page. 
- To view the History Report. 

 
 
As you proceed you may see MineSearch or other information for which you 
have different or better data. Most categories on the Profile page can be edited 
using the Edit button .  Updating these fields in the “User” spaces does not 
alter the MineSearch information, and allows both versions of the data to be 
searched. A history of the updates to each item and who made those updates is 
maintained. (Note - only administrators can change MineSearch data. These 
fields will be overwritten on the next MineSearch ingest.) 
 
ACTION:  
  
 1. From the Profile page click  to go to the Profile Edit page. (Figure  
     1C) 
 
 2. Choose a field, and if needed, click the pencil icon   or  and  
     enter a change in the edit window for that field (Figure 2C). (Note:  
     Some items have a text box for data.) 

 
3. Click  to accept all your changes. 
 
4. On the updated Profile page click on  next to an item you just edited  
    (Figure 3C). (Note: This feature is only available when there are History  
    items to view) 
 
5. From the Reports menu select History Report. (Figure 4C) 
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Figure 1C – Profile Edit Page 
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Figure 2C – Editing a field 

 
 

 
Figure 3C – History of an Item 

 
 

 
Figure 4C – History Report Menu Selection 
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NOTES: 
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D. Documents 
 
Objectives:  
 

- To find and read information on an ACIS View Documents page. 
- To perform simple operations such as opening folders and subfolders. 
- To become familiar with folder and subfolder icons and their related 

actions. 
- To add a document to an ACIS View Documents page. 
- To add a document as text. 

 
 
Now let's look at the contents of an ACIS View Documents page. On the 
Canariaco Documents page you know there are documents in the Economic 
Models folder because of the number appearing in parentheses after the folder 
name. When you click on the folder icon  it reveals the document file name.  
 
When you click on the text of the folder label you have four options: add a folder, 
add documents, add a web link or add text at the same level.  
 

 
 
When we click on a document file name, it doesn't immediately open the 
document. We see there are five options. 
  

 
 
ACTION:  
  
 1. From the Profile page click on the View menu. From the drop-down list  
     select Documents. (Figure 1D) 
 

2. Click on the folder label to review options available. (Figure 2D) 
 
3. Select Add a Document to add content to the folder. You can add  
    multiple documents in the same session. (Figure 3D) 
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4. Click on the folder label again and select Add Text. In the pop-up 
    window type a name for your new text document and give it a  
    description if desired. (Figure 4D) 
 
5. Copy a piece of text from a web site or word processor document.  
    Paste the text into the document text area. Click  and note the  
    new .txt document in the folder. 
 
6. Click on the now populated folder (one with a number, other than zero, 

        in parentheses). (Figure 5D)  
 
 7. Click on a document file name to review and practice with the options  
     available. (Figure 6D)  
  
 

 
Figure 1D – Documents Option on View Menu 

 
 

 
Figure 2D – Add a Document 

 

 
Figure 3D – Adding a Document 
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Figure 4D – Add Text Document 

 

 
Figure 5D – Folders 
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Figure 6D – Document file Menu Options 
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NOTES: 
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E. Aliases and Quick Navigation Button – Find 
 
Objectives: 
 

- To use a quick navigation feature to easily find ACIS Views. 
- To add an alias. 

 
 
The Find button allows you to quickly find an ACIS View from anywhere in the 
system. Some ACIS Views may have the same or similar names. By filtering your 
Find Results by category the system provides additional information to help you 
decide easily which ACIS View you wish to access. 
 
ACIS Views may be referred to by alternate names in databases, news articles or 
internally by different business units or individuals. ACIS® provides a way to 
make sure it is easily identified by capturing alternate names in an “alias” 
functionality. The system can search based on any alias added to an ACIS View. 
 
ACTION:  
 
 1. Click on the ACIS View Find button  to access the pop-up.     
 
 2. Search for Abbott. (Note there are a few result options.) (Figure 1E) 
 
 3. From the Filter drop-down box select Projects (Figure 2E). Additional 
     information will allow you to select the correct project. Select one result. 
 
 4. Go to the GUANIAMO project. From the Functions menu, select  
     View/Create Aliases. (Figure 3E) 
 

5. In the Alias pop-up window type another Alias for the ACIS View  
    and click   (Figure 4E). To View the added alias select       

     View/Create Aliases from the Functions menu. 
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Figure 1E – Search Pop-up 

 

 
Figure 2E – Filtered Find Results 

 

 
Figure 3E – Functions Menu 
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Figure 4E – Alias Pop-up Window 
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NOTES: 
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F. Flags and Intelligence Summary Report 
 
Objectives: 
 

- To enter a flag comment. 
- To add a web link to a flag comment. 
- To find and read flags by category and chronological sequence. 
- To view all comments/flags on a particular ACIS View. 
- To access the Intelligence Summary Report. 

 
 
Look again at the Canariaco Flags page. You will now add a comment and then 
read what others have entered on the page.  
 
Once an ACIS View has a number of flags, you may want to read the flags by 
categories (for example, Value Indicators or Early Warning Signals), or in 
chronological order. In both cases, they appear in reverse chronological order. 
 
The Intelligence Summary Report summarizes intelligence across a specified set 
of ACIS Views for a given period of time OR provides a summary of the 
intelligence entered for a single ACIS View.  It is accessible from the Reports 
menu on the Intelligence tab page and any ACIS View.  
 
ACTION:  
  

1. Go to Canariaco’s Flags page. 
 
 2. Review the flag categories in the left column. (Figure 1F) 
 

3. On the Flags page, in the Action column, click on the Add-a-Comment 
    icon . 

 
 4. In the Comment pop-up window type in your comment. (Figure 2F) 
 
 5. Click  . Enter a name for the link and URL for the link and  
     click . (Figure 3F) 
 
 6. Press . The comment appears on the flags page under the  
     appropriate heading. The paperclip icon at the lead of the comment  
     Indicates that a web link is attached. (Figure 4F). A single click on the  
     paperclip will open the list of web link attachments. Clicking on any of  
     the web links will open a cached page. Click refresh on your browser to  
     refresh your page and see all comments entered by others in your  
     training session. 
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 7. In the Action column click on any  and read the comments.  
     Comments can be deleted by the submitter within 20 minutes of entry  
     directly from the Flags page or the Intelligence tab page. Administrators  
     can delete flag comments at any time. 
 
 8. Click on   to see all the comments/flags associated with  
     the ACIS View. (Figure 5F) 
 
 9. Look at the Homepage Intelligence Window and locate the comment     
     you entered. (Note how your comment has been formatted. You can 

    link directly via email to the source of the comment. You can link directly  
   to the Flags page of the ACIS View where the comment originated) 
 
10. Return to the Canariaco Flags page by clicking on its name in the 
    Intelligence window. From the Reports menu, select Intelligence  
    Summary. (Figure 6F). Select a date range from the pop-up. View the  
    report. (Figure 7F) 
 
11. From the Filter by drop-down list select ALL Views (Figure 8F). Click  
     and a report showing all flag entries for the given period of time  
    will be displayed. (Figure 9F) 
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Figure 1F – Flags Page 

 
 

 
Figure 2F – Enter a Flag Comment 

 



   

ACIS® Orientation and Training Guide  33 

 
Figure 3F – Add Web Link 

 

 
Figure 4F – Open Flag Entry 

 

 
Figure 5F – Flags Page View All Comments 

 

 
Figure 6F – View Intelligence Summary Report 
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Figure 7F – Intelligence Summary Report 

 
 

 
Figure 8F – Filter by All Views 

 

 
Figure 9F – Intelligence Summary Report for All Views 
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NOTES: 
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G. Searching 
 
Objectives: 
 

- To search comparable ACIS Views. 
- To generate an Intelligence Matrix report. 
- To view the Intelligence Summary report based on current search results. 
- To search documents within ACIS. 

 
 
Suppose you want to review similar Projects, or Companies, or any group of 
ACIS Views that meet certain criteria. You can search on all profile and flag 
criteria in various combinations.  For example you can search for all gold projects 
in Asia in the reserves development stage. 
 
The Documents tab contains the functionality for searching all documents 
internal to the ACIS system. This includes key word searches, searching by date 
and document submitter. The search can be further refined by filtering on specific 
categories. 
 
ACTION:  
  
 1. Click on the Search tab.  
 
 2. In the Category drop-down list select “Projects” (Figure 1G). (Tip: If you  
     want to see all the entries within a category perform a search without  
     selecting any further criteria.) 
 
 3. From the criteria list select “Primary Metal”, “Name” and enter  
     “Gold” in the text box. (Figure 2G) 
 

4. Click . Note that the number of results appears on the search  
    page. (Figure 3G) 
 
5. From the criteria list select “Region”, select “Asia” from the  
    list. Select “Project Status” from the criteria list and choose “Reserves  
    Development”. (Figure 3G) 
 
6. Click on  to go to the Search Results page. (Figure 4G) 
 
7. You can click on (Profile),  (Flags) or  (News) to go to the  
    different sections in any of the ACIS Views listed. 
 
8. From the Reports menu select Intelligence Matrix. (Figure 5G). Click  
    close. 
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NOTE: You can search across categories - searching for related information 
contained within multiple categories. Keep in mind that the search results will 
always appear in the Category type you originally selected. 
 
 9. From the Reports menu select Intelligence Summary. View the report.  
     (Figure 6G) 
 
 10. Click on the Documents tab to access the Document search page.  
      (Figure 7G) 
 
 11. Enter key words, select a submitter, date range and/or a filter. View  
      the results. Clicking on a document name will open the document in a  
      new window. 
 
 

 
Figure 1G – Selecting a Search Category 

 
 

 
Figure 2G – Entering Search Criteria 
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Figure 3G – Search Criteria Results 

 
 

 
Figure 4G – Search Results Page 
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Figure 5G – Matrix Report 

 

 
Figure 6G – Intelligence Summary based on Search Results 
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Figure 7G – Document Search Page 
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NOTES: 
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H. Save Searches 
 
Objectives: 
 

- To save a search. 
- To view saved searches. 
- To execute a saved search. 
- To edit a saved search. 

 
 
Next you may want to keep informed about any changes to your set of ACIS 
Views. A Saved Search becomes a continuous filter. High priority alerts show up 
on the Homepage in the Alerts Window whenever there are new flags, 
documents, news or changes in profile information related to that Saved Search. 
Alerts will also be triggered if an ACIS View enters the scope of a saved search 
or if an ACIS view no longer meets the criteria of a saved search. Non-high 
priority alerts can be seen, as can the high-priority ones, on the Alerts page. 
Alerts can also be sent to your email in box. 
 
ACTION:  
  
 1. Click on the Search tab select Save Current Search from the 

    Search menu. (Figure 1H) 
 
 2. In the pop-up window name the search and set the priority to High.  
          Click  (Figure 2H). Clicking the Email Notification box will send  
     alerts related to this saved search to your email in box. 
 
 3. On the Search menu click View Saved Searches. (Figure 3H) 
 
 4. Click on  to execute a search from the list. (Figure 4H) 
 
 5. Return to the Saved Searches list. If you click on  you can edit the  
     search criteria. 
 
 

 
Figure 1H – Select Save Search 
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Figure 2H – Naming a Search 

 
 

 
Figure 3H – Viewing Saved Searches 

 
 

 
Figure 4H – Saved Search List 
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NOTES: 
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I. Entering Flag Comments to Trigger an Alert 
 
Objectives: 
 

- To review entering a flag comment. 
- To see an alert triggered by a flag entry on the Homepage and the Alerts 

page. 
 
 
Anything entered on a Flags page, an edit to a Profile page, or a new entry to a 
Documents page for an ACIS View that's part of a Saved Search will trigger a 
new alert on the Alerts page. If the saved search was set to High Priority, the 
alert will also appear in the Alerts window on the Homepage. Medium and Low 
priority alerts appear on the Alerts tab page. 
 
ACTION:  
  
 1. Execute a Saved Search you set as High Priority.  
 
 2. On the Search Results page click on  next to the name of a search 

    result. 
 

3. On the Flags page, in the Action column, click on the Add-a-Comment 
    Icon . 

 
 4. In the Comment pop-up window type in your comment and press    
     . 
 
 5. Wait a few minutes. Click on the Homepage tab to go to  
     the Homepage. The comment will appear in the Intelligence Window 

    and the Alerts Window. (Figure 1I) 
 
 6. Click on the Alerts tab. The Alert will also appear in this list. (Figure 2I) 
 
NOTE: Clicking on the column headers on the Alerts page will sort alerts by that 
header topic. 
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Figure 1I – New Comment Appearing as Intelligence Item and Alert on Homepage 

 
 

 
Figure 2I – Alerts Page 
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NOTES: 
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J. News and Linking News 
 
Objectives: 
 

- To review the news page. 
- To view a detailed news article. 
- To link a news article to an ACIS View. 

 
 
The ACIS® News section is a utility that provides you with the latest news in the 
industry marketplace. The news items captured are from your company’s 
subscribed-to news feed services. 
 
News articles can be associated with any ACIS View in the system. 
 
ACTION:  
  
 1. Click on the News tab to go to the main News page. (Figure 1J) 
 
 2. Click on a news headline to go to a News Detail page. (Figure 2J) 
 
 3. On the View News Article page, under Linked ACIS Views, click . 
 
 4. On the pop-up window, Search for an ACIS View you wish to link to  
     and select it. News links can be deleted by their creator or an  
     administrator. 
 
 
 

 
Figure 1J – Main News Page 
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Figure 2J – News Detail Page 
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K. Search News 
 
Objectives: 
 

- To search news. 
- To save a news search. 
- To access saved news searches. 

 
 
This feature allows you to quickly search for news available within the ACIS® 
system by keywords, pre-defined patterns and date ranges. Let’s look for News 
on Goldcorp. 
 
Boolean operators AND, OR, AND NOT can be used in the keyword search. 
 
ACTION:  
  
 1. Click on the News tab. 
 
 2. Click on “Search News” to open the Search for News pop-up box.  

    (Figure 1K) 
 
 3. Enter key words, select from the drop-down list of pre-defined patterns,  
     and/or select a date range. 
 
 4. Click the Search button . View the results.  
 
 5. Click on “Search News” again, click on the Save button .  
 
 6. Fill in the information in the Save/Modify News Search pop-up window.  
     (Note: setting the priority to high means the alert from the search will  
     show on your homepage). Click Submit to save the news search.  
     (Figure 2K) 
 
 7. Click on “Search News” again, then click on the Saved Searches button 

     .  
 
 8. From the View Saved News Searches box (Figure 3K) execute your  
     search again by clicking on the check mark button . 
 
HINT: You know you are viewing News Search Results because (Filtered ) 
appears in the main News header. To remove the filter click . 
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Figure 1K – Search News Pop-up 

 
 

 
Figure 2K – Save News Search 

 
 

 
Figure 3K – View Saved News Searches 
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L. More ACIS View Reports 
 
Objectives: 
 

- To generate various reports based on ACIS View data. 
- To export search results to Excel. (available if Excel is on your PC) 

 
 
When you have sufficient information and you know an item is of interest, you 
may want to create a report to send to other relevant parties. 
 
Each ACIS View has a set of report types: a Summary, Detail, History, and 
Intelligence Summary. You also have the ability to export all the profile data to 
an Excel spreadsheet for Project ACIS Views. 
 
ACTION:  
  
 1. On a Flags Page which contains comments click on the Reports menu.  
    (Figure 1L) 
 
 2. Select Summary Report and review its contents. (Figure 2L). Click    
     .  
  
 3. Select Detail Report and review its contents. (Figure 3L). Click . 
 
 4. Select History Report from the menu and review its contents (Figure  
     4L). Click .  
 

5. Select Export ALL Profile Data and review in Excel. This report is also  
    available for groups of ACIS Views in a search results list. 
 
6. Open or save the Excel spreadsheet as indicated by your operating  
    system. 

  
 
 

 

 
Figure 1L – Reports Menu 
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Figure 2L – Summary Report 
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Figure 3L – Detail Report 
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Figure 4L – History Report 
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M. Quick Navigation Button – Create 
 
Objectives: 
 

- To use quick navigation features to easily create ACIS Views. 
- To learn the difference between Quick Create and Create & Populate. 

 
 
The Create button allows you to create an ACIS View from anywhere in the 
system. This is useful when you want to add information to an existing profile for 
a category (i.e. Associated People) that will only allow an entry that already has a 
record elsewhere in the system, or when you want to create an entirely new 
ACIS View.  
 
ACTION:  
 1. Click on the ACIS View Create button  (on the top right of your  
     screen) to access the Create an ACIS View pop-up box (Figure 1M). 
 
 2. Select a category and type in a name. Click . 
 
 3. Find the ACIS View you just created. 
 
NOTE:  allows you to create an ACIS View and immediately begin 
to populate its Profile page. 
 
 

 

 
Figure 1M – Create an ACIS View Pop-up 
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N. Quick Navigation Button – History 
 
Objective: 
 

- To use quick navigation features to access recently visited ACIS Views. 
 
 
The History button provides a drop-down list of the last 20 ACIS Views you  
visited. Icons indicate which part of the ACIS View you accessed. 
 
ACTION:  
  
 1. Click on the History button  near the top right of your  
     screen. (Figure 1N) 
 
 
 

  
Figure 1N – History Drop-down List 
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O. Quick Navigation Button – Favorites 
 
Objectives: 
 

- To create a favorites list. 
- To use quick navigation features to easily access the Favorites List. 

 
 
The Favorites button provides a drop-down list of up to 20 personally specified 
ACIS Views for quick access. You can receive alerts on this list on the My 
Workspaces page. 
 
ACTION:  
  
 1. Click on the Workspaces tab. 
 
 2. On the My Workspaces page click on Personal Favorites (Figure 1o,  
     2o). 
 
 3. From the View menu select “Linked ACIS Views” (Figure 3o, 4o). 
 
 4. Click on the link button . Search for “Newmont”.  
 

5. Click on the Favorites button . The ACIS View you linked 
    now appear in your Favorites drop-down list for quick access from  
   anywhere in the system (Figure 5o). 
 
OR 
 
6. From any ACIS View click on the Functions menu and select Add to 
    Favorites. (Figure 6o). A message will confirm the addition to the list. 

 
 
 

 
Figure 1o – My Workspaces 
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Figure 2o – Personal Favorites Workspace 

 

 
Figure 3o – Workspace View Menu 

 

 
Figure 4o – Linked ACIS Views Page 

 

 
Figure 5o – Favorites List 

 

 
Figure 6o – Add to Favorites Selection 
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P. Creating a Workspace 
 
Objectives: 
 

- To create a workspace. 
- To access and use project functionality within a Workspace. 
- To create a task list. 

 
 
Let's assume a team gathers and is now needed to investigate an opportunity in 
more detail or to review strategic options. You can use ACIS® to create a 
Workspace for this team.  
 
An ACIS® Workspace is a private area designed to provide a user (or a group of 
users) with a space for documentation and resource collection, project task 
management, custom flags and tracking email-based discussions. A Workspace 
can be created for any topic, whether or not it's related specifically to targets or 
competitors. 
 
ACTION:  
  
 1. Click on the Workspaces tab. (Figure 1P) 
 
 2.  From the Workspaces menu select “Create Workspace”. (Figure 2P) 
 
 3. On the Create Workspace page, select “Project” to reveal Project  
     options. (Figure 3P) 
 
 4. Give the Workspace a name and description. 
 
 5. Enter a workspace email address, username and password as provided  
     by your instructor (optional). 
 
 6. Assign two other members to your workspace by clicking on  
      and selecting names in the pop-up window. (Figure  
     4P) 
 
 7. Fill in the Project-related information, setting the Priority to High. Select  
     a Project Status and Type. 
 
 8. Return to the My Workspaces page to view your recently created 

    Workspace in the list. (Note: The ‘P’ next to the Workspace  
    name denotes that it has Project functionality.) 
 
9. Click on the name of the Workspace you just created to go to the 
    Workspace Profile page. (Figure 5P) 
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10. From the View Menu select “Task List” (Figure 6P) to view the Task  
      List page. (Figure 7P) 
 
11. Click on . Fill in the information in the Task form (Figure 8P).  
      Assign the task to a Workspace member and set start and end dates.  
      Set status to “In Progress”. 
 
12. Click on  and fill in the sub-task information. Assign the 
      sub-task to a Workspace member and set start and end dates.  
 
13. Click . 
 
14. View your Task Page to see the Task and the Sub-task you created. 
 

 
 

 
Figure 1P – My Workspaces Page 

 
 

 
Figure 2P – Workspaces Menu 
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Figure 3P – Create Workspace Page 

 
 

 
Figure 4P – Assign Workspace Members 
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Figure 5P – Workspace Profile 

 
 

 
Figure 6P – View Task List 
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Figure 7P – Task List Page 

 
 

 
Figure 8P – Add Task Page 
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Q. Workspace Documents, Alerts, Emails and News 
 
Objectives: 
 

- To access Workspace documents and link ACIS View documents to a 
Workspace. 

- To link ACIS Views to a Workspace and generate a Workspace alert. 
- To use Workspace Email. (optional) 
- To Link News articles to a Workspace. 

 
 
 
ACTION:  
  

1. From the View menu, select “Documents”. You’ll notice a folder has 
    been created to correspond with each Task in your Task list.  
    Documents work in exactly the same way as ACIS View documents.  
    However, ACIS View documents can be linked to a Workspace.  

 
2. Go to an ACIS View containing a document. Click on the document 
    name and select “Add Document to Workspace”. Choose the  
    Workspace you created from the list (Figure 1Q, 2Q). 

 
 3. Return to the My Workspaces page and view the Workspace to which  
     you just added a document. (NOTE: Red numbers appear on the 

    My Workspaces page when new items have been added to a 
    Workspace. You should also see a red ‘*’ next to new items in the  
    workspace sections.) 
 
4. Select “Linked ACIS Views” from the View menu. (Figure 3Q) 
 
5. On the Workspace Linked ACIS View page click . Search for,  
    and select, an ACIS View you wish to link to this Workspace. 
 
6. Go to the ACIS View you just linked by clicking on its name and make  
    a change to its Profile, Flags or Documents page. 
 
7. Return to My Workspaces. Take note of the new alert indicated by the  
    number. Click on the number to view the alert you just entered. (Figure  
    4Q) 
 
8. Open your email client and send an email to the Workspace email  
    address provided by your instructor. (optional) 
 
9. Return to ACIS® and go to the My Workspaces page. 
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10. Look in the New Emails Column for any new emails. Click on the  
      number to go to the Workspace email list (Figure 5Q). Click on , 
      to open the email detail page. Click on  to open a group of emails  
     with similar subjects. 
 
11. Clicking on the email address of the author on the email list page, or  
      on the email detail page allows you to send a reply email to the author 
      and cc the workspace. Workspace email can be deleted by the  
     Workspace owner and system administrators. 
 
12. Click on the News tab and open a news article. 
 
13. In the Linked Workspace box, click  (Figure 6Q). Select a  
      Workspace and link the article. 
 
14. Click the Workspaces tab. Click on the name of the Workspace to  
      which you just linked the article.  
 
15. From the View menu, Select “News”. A link to the article appears on 
      this page. (Figure 7Q) 

 
 

 

 
Figure 1Q – Add Document to Workspace 

 
 

 
Figure 2Q – Workspace Selection List 
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Figure 3Q –  Linked ACIS View Page 

 
 

 
Figure 4Q –  My Workspaces Showing New Alerts 

 
 

 
Figure 5Q –  Workspace Email List 

 
 

 
Figure 6Q – Link a Workspace 
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Figure 7Q – Workspace News 
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R. Workspace Flags 
 
Objectives: 
 

- To create workspace flag categories and flags. 
- To enter a workspace flag. 

 
 
Workspaces can have their own set of flags to which only Workspace members 
can view and add comments. These flags could be related to specific key 
intelligence topics or questions, key strategic topics or questions, time sensitive 
or short-term projects, targeted research, etc. 
 
Flag comments are a method of tracking important information through user input 
in ACIS. Flag comments are permanent records of primary information related to 
a Workspace topic area. 
 
The Workspace Owner has the authority to create and manage flag names, 
descriptions, and categories.  Workspace members can add comments to flags. 
 
ACTION:  
  
 1. Enter a Workspace you own from the My Workspaces page. 
 
 2. On the Workspace Profile page, click the View menu and select  
     Workspace Flags from the drop-down list (Figure 1R). 
 
 3. On the Workspace Flags page, click the Edit button (Figure 2R.) 
 
 4. On the Workspace Flags Edit page click . 
 
 5. In the pop-up box enter a Flag Category name and click .  
     (Figure 3R, 4R) 
 
 6. Under Action, click on  to access Category Options (Figure 5R). 
     Select Add New Flag from the menu. 
 
 7. In the pop-up box enter a Flag name. (Figure 6R, 7R) 
 
 8. Repeat steps 6 and 7 until you have a couple categories with several  
     flag names. (Figure 8R) 
 
 9. Under Action, click  to the right of a flag name (Figure 9R). Flag 
     options include edit, delete, change category and movement up or  
     down. Practice using these options to see their effects. 
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 10. Click  to complete editing flags (Figure 10R). The Workspace   
       flags page is ready to accept flag comments. Practice entering a  
       comment. 
 
 
 
 

 
Figure 1R – Access Workspace Flags 

 

 
Figure 2R – Edit Workspace Flags 

 

 
Figure 3R – Add New Flag Category 
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Figure 4R –Workspace Flag Edit Page with New Category 

 

 
Figure 5R –Category Options  

 

 
Figure 6R – Add New Flag  

 

 
Figure 7R –New Workspace Flag  

 

 
Figure 8R – Editing Workspace Flags 
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Figure 9R – Flag Options 

 

 
Figure 10R – Workspace Flags 
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S. Workspace Reports 
 
Objectives: 
 

- To access the MyProjects Report. 
- To access a Detailed Project Report. 
- To export a report to Word. 

 
 
Workspaces have two types of reports: a MyProjects Report and a Detailed 
Project Report. 
 
The MyProjects Report gives you a summary listing of all Workspaces with 
project-related functionality you own or of which you are a member. 
 
The Detailed Project Report provides an overview of a single project-related 
Workspace. 
 
ACTION:  
  
 1. From the My Workspaces page, click the Reports menu and select  
     MyProjects Report from the drop-down list. (Figure 1S, 2S) 
 
 2. Click  to return to the My Workspaces page.  
 
 3. Click on the name of a Workspace with project functionality. (indicated  
     by a ‘P’ next to the Workspace name) 
 
 4. From the Reports menu, select Detailed Project Report. (Figure 3S) 
 
 5. Click on . 
 
 
 

 
Figure 1S –  Workspace Report Menu 
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Figure 2S –  MyProjects Report 

 
 

 
Figure 3S – Detailed Project Report 
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T. Maintaining a Workspace 
 
Objectives: 
 

- To delete members of a Workspace. 
- To close a Workspace. 

 
 
As the owner of a Workspace you can delete members and close a workspace 
once a project is complete. 
 
A user with administrative rights can delete members and Workspaces 
regardless of ownership rights. 
 
All documents and flags must be removed from a Workspace before it can be 
deleted. 
 
ACTION:  
  
 1. On the My Workspaces page select a Workspace of which you are the   
     owner.  
 
 2. On the Workspace screen click the View menu and select Profile.    
 
 3. Click on the edit button . 
 
 4. Press the Delete button  beside one of the members to delete 

    him/her from the workspace. 
 
 5. Click OK to accept the change. 
 
 6. Go to the documents page of this Workspace and delete all documents.  
     Do the same for flags. (NOTE: A Workspace cannot be closed until all  
     contents have been removed.) 
 
 7. Go to the My Workspaces page. An  should appear in the right-hand  
     column next to the Workspace you just visited. (Figure 1T) 
 
 8. Click on the  to delete the Workspace. 
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Figure 1T – Deleting a Workspace 
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U. User Options 
 
Objectives: 
 

- To set up the Notifications function. (optional) 
- To view and read a notification. (optional) 
- To change your user password. 
- To install the ACIS Desktop Alert Tool. 

 
 
The User Options section includes functions for changing your password and 
email address preferences. 
 
Notifications allow you to have email-based messages sent to the ACIS® 
Homepage. You will need to request an alternate email account be assigned by 
your System Administrator prior to this feature becoming functional. 
 
High priority alerts can be sent directly to your desktop using the Desktop Alert 
Tool. 
 
ACTION:  
  
 1. Click on the User Options menu at the top of the screen. (Figure 1U) 
 
 2. On the User Options screen note the change password functionality.  
     You may change your password at this time. 
 

3. Enter a notifications email address as provided by your instructor.  
    (optional) (Figure 2U) 
 

 4. The trainer will send you an email. Check the Notifications window on  
    the Homepage for a new message. (optional) (Figure 3U) 

 
 5. In the Download Tools box select the ACIS Desktop Alert Tool.  
     (Figure 4U). The Help menu contains hints for loading the tool. 
 
 6. In the pop-up box select Run to immediately install the tool or save to  
     store a copy on your hard drive for installation at a later time.  
     (Figure 5U). Internet Explorer may indicate some security messages.  
     Check with your System Administrator on proper procedures. 
 
 7. In the Preferences box enter your ACIS login URL, your username and  
     password. (Figure 6U) 
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 8. An icon should appear in your system tray. (Figure 7U) 
 
 9. When you receive a high priority alert, even if ACIS is not open on your 
     system, the icon will change and a small pop-up will appear including  
     information regarding that alert. Clicking on the icon or any link in the    
     pop-up will open ACIS and take you to the relevant ACIS section. The  
     pop-up will only remain for a short time and then will fade. However, the  
     icon will remain in an ‘alert’ state until you have read your new alerts.  
    (Figure 8U) 
 
 10. Return to the main system by clicking  . Generate an alert on your  
       desktop by triggering a saved search. 
 
 

 
Figure 1U – Options Button on Page Top Header 

 
 

 
Figure 2U – User Options Page 

 

 
Figure 3U – Notification on Homepage 
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Figure 4U – Download ACIS Desktop Alert Tool 

 

 
Figure 5U – Run or Save Installer 

 

 
Figure 6U – Desktop Alert Tool Preferences 

 

 
Figure 7U – Desktop Alert Tool Icon 
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Figure 8U – Receiving a Desktop Alert 
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User Support and Reporting Bugs 
 
Contact information: 
 
Phone: 902.423.4454 
Email:  support@coemergence.com 
 
  
 
Guidelines for notifying Coemergence 
 
If you should find a system bug, or have a suggestion for future improvement, 
please send us an email to support@coemergence.com, containing the following 
items: 
 
1. The URL of the web page on which you discovered the issue 
2. The steps taken to achieve the result  
3. Any important details about what was seen 
4. Your contact information – name, phone, and email 
 
Example: 
I encountered an error on the following page: 
http://acis.companyname.com/entityprofile_update.prey 
  
I had just clicked the submit button on the profile page, and the error happened.  
  
Margot 
m.smith@companyname.com 
 

  

 




